Creating Rooms and Area Plans

Rooms are another example of why Revit is considered the BIM application. When we add a room, we not only add a simple descriptive piece of text, we add an element that knows the square footage, the volume, and even the occupancy of an area. Also, if you think about it, as an architect adding a room, you are adding critical information for the MEP HVAC consultants when they link your model!

- Creating rooms
- Adding a room schedule
- Adding a color-fill plan
- Adding room separators
- Creating an area plan

Creating Rooms

The first topic we’ll tackle is the task of creating a room and adding it to the model. The procedures that follow will focus on finding where to launch the room and areas and the parameters the Autodesk® Revit® Architecture software looks for while placing a room into the floor plan.

Because Revit draws from a database to gather information, the process of creating a room boils down to your adding some notes to an already-built form. When you place the room in the model, Revit automatically tags it. Unlike other drafting applications, however, Revit doesn’t rely on the tag for its information. When a room is in the model, it can either contain or not contain a tag. This is a great way to organize the flow of room information.

To get started, open the model on which you’ve been working. If you skipped the previous chapter, go to the book’s web page at www.sybex.com/go/revit2017ner. From there, you can browse to Chapter 14 and find the file called NER-14.rvt.
The objective of the following procedure is to find the Room & Area panel on the Architecture tab and to configure and add some rooms to the model. Follow these steps:

1. In the Project Browser, find the dependent view called Level 1 East, and open it.
2. On the Architecture tab, click the Room button.
3. Hover your cursor over the southeast room, as shown in Figure 14.1. An X appears, along with the outline of a room tag.

![Figure 14.1: When you hover your mouse over the intended area of the room, you see an indication that Revit has found the bounding edges.](image-url)

4. Pick a spot in the middle of the four walls.
5. Press Esc.

You’ve now added a room to the model. Of course, it’s a nondescript room name with a nondescript room number. Let’s correct that by changing the room name and number on the screen.

1. Select the room tag that you just added to the model.

**NOTE** You may be sick of hearing this by now, but I’ll say it again: when you select a component in Revit, the items that turn blue are always editable.
2. Click the Room text.
3. Change the name to SOUTHEAST CORNER OFFICE.
4. Click room number 1.
5. Change the number to 101 (see Figure 14.2).

![Figure 14.2: Changing the room name and number to SOUTHEAST CORNER OFFICE and 101, respectively](image)

Now that you have a room in place and it’s named properly, you can start cooking in terms of adding more rooms. This is because Revit will begin to number the rooms sequentially as you place them into the model.

Next you’ll populate the rest of the east wing with rooms. Follow these steps:

1. On the Room & Area panel of the Architecture tab, click the Room button.

   **T I P** If you get the Save reminder, be sure to save the model. In no situation is this ever a bad idea!

2. Place a room in the adjacent area, as shown at the lower left in Figure 14.3.
3. Call the room SOUTHEAST CONFERENCE (see Figure 14.3).

**NOTE** Did you notice that the room tag tries to align itself with the adjacent tag? This is a fantastic feature in Revit Architecture.

4. On the Room & Area panel of the Architecture tab, click the Room button again.

5. Place a room in the radial entry area.

6. Rename the room EAST ENTRY.

7. Renumber the room 001.

8. Place a room in the south elevator shaft.

9. Rename and renumber it SOUTHEAST ELEVATOR and 010.

10. Place a room in the north elevator shaft.

11. Rename and renumber it NORTHEAST ELEVATOR and 011.

12. Place a room in the corridor.

13. Call it EAST WING CORRIDOR, and number it 100.
14. Just north of SOUTHEAST CONFERENCE and SOUTHEAST CORNER OFFICE, place two rooms, each called GATHERING. Number them 103 and 104.

15. Zoom over to the west portion of the east wing, where the lavatories are located.

16. In the north lavatory, add a room named MEN'S, numbered 105.

17. In the south lavatory, add a room named WOMEN'S, numbered 106.

I think you're getting the concept of adding rooms. Although you've added a number of rooms to the east wing, you need to begin adding some plain-old offices. The next procedure will involve adding offices to the rest of the spaces in the east wing of Level 1. From there, you can look at a room's properties and figure out how to alter the room information. Follow these steps:

1. Make sure you're in the east wing area of the model, on Level 1.

2. On the Room & Area panel of the Architecture tab, click the Room button.

3. Pick the large area to the right of the women's lavatory, as shown in Figure 14.4.

**Figure 14.4:** Renaming the office
4. Rename the room OFFICE, and change the number to 107 (see Figure 14.4).

**NOTE** If the numbering starts to become inconsistent with the examples in the book, that’s OK. This will happen from time to time in Revit. You can accept the differences between the book and your model, or you can renumber the rooms to match. Either way, the numbering won’t affect the outcome of the procedures.

5. Click the Room button.

6. Add rooms to the rest of the vacant areas, renaming them all OFFICE. (Skip the kitchen area and the room to the right of it, as shown in Figure 14.5.)

![Figure 14.5: Adding rooms to the remainder of the spaces](image_url)

With all the rooms in (at least in this section of the building), you can begin examining specific properties to see how you can add functionality and further populate the database information pertaining to each room.

**Configuring Properties**

Each room has specific properties associated with it. There are floor finishes and wall finishes as well as ceiling types and finishes. It would be nice if Revit picked up this information by “reading” the ceilings, walls, and floors, but it doesn’t.
And for good reason—imagine having to create a different wall type for each paint color and then splitting each partition as it passed through each room. In Revit, you specify individual room finishes in the properties of the room itself. In the next procedure, you’ll generate additional room information in the properties of the room. Follow these steps:

1. Zoom in on the SOUTHEAST CORNER OFFICE 101 room.
2. Hover your cursor over the room until you see the X, as shown in Figure 14.6.

![Figure 14.6](image)

**Figure 14.6:** Hover the cursor over the room until the X appears.

### TIP
Any time you want to view the properties of a room, you need to click the actual room, not the room tag. Sometimes selecting a room can be difficult because the room is invisible until you hover over it. With some practice, this process will soon become second nature.

3. Pick the room, as shown in Figure 14.7.
4. In the Properties dialog box, scroll down to the Identity Data group.
5. Add WD-1 to Base Finish.
6. Add ACT to Ceiling Finish.
7. Add PT to Wall Finish.
8. Add VCT to Floor Finish (see Figure 14.8).
9. Select the SOUTHEAST CONFERENCE room.

10. In the Properties dialog box, click into the Base Finish field. Click the arrow for the pull-down menu, and select WD-1, as shown in Figure 14.8.

11. Change the rest of the fields using the previous entries.

12. Save the model.
Changing a room’s properties is a simple task. There is, however, one more item to discuss. It pertains to a room that spans multiple floors, such as the east entry.

The objective of the next procedure is to change the height of the east entry room’s properties.

1. Zoom in on the east entry area, and select the room, as shown in Figure 14.9.

2. In the Properties dialog box, change Upper Limit to Roof.

3. Change Limit Offset to 0. Doing so sets the east entry room to extend from Level 1 to the roof.

Now that you have experience changing the properties of the rooms, it’s time to look at the properties of the walls that divide the rooms. You certainly noticed that when you placed the rooms in the lavatories, the rooms didn’t fill the small entry areas. You can correct this by changing the walls’ room-bounding properties.
Room-Bounding Properties

By default, each wall you add to the Revit model automatically defines a room boundary, and this is what you want 95 percent of the time. In some situations, however, you don’t want a wall to separate the room. In such cases, you can modify the instance parameters of the wall to disallow the division of the room.

In this procedure, you’ll turn off the room bounding in certain walls. Follow these steps:

1. In the East Wing floor plan, zoom in on the lavatory area.
2. Select the wall that divides the men’s toilet area from the men’s lavatory entry area, as shown in Figure 14.10.

![Figure 14.10: Selecting the partition within the men's lavatory](image)

3. In the Properties dialog box, scroll down to the Room Bounding row.
4. Deselect Room Bounding (see Figure 14.10).
5. Repeat the procedure in the women’s lavatory.
6. Save the model.

Having the ability to add rooms and manipulate the information easily in the Revit database gives you a tremendous advantage as you move forward with the rest of the model. Also, that information is relayed into the room’s tag, which is automatically added as you place rooms into the model.
This concept brings us to the next topic: how to change the tag to display the information you desire on the drawings.

**Placing and Manipulating Room Tags**

As mentioned earlier, the room tag is merely a vehicle to relay the room’s data to the construction documents. As a default, a room tag is added automatically as you place the room into the model. A default room tag is included, but you aren’t stuck with it.

Let’s add an alternate room tag to the room and open the tag’s Family Editor to investigate the composition of the tag:

1. Zoom in to SOUTHEAST CORNER OFFICE.
2. Select the room tag.
3. In the Type Selector, select Room Tag With Area. The tag displays the area, as shown in Figure 14.11.

![Figure 14.11: Change the type to Room Tag With Area.](image)

That was way too easy! Let’s take a closer look at what you just did. A room tag is nothing more than the cover sheet label you created in Chapter 13, “Creating Sheets and Printing.” All you need to do is open the file and place a tag into the family.

To open the tag’s Family Editor, follow this procedure:

1. Select the room tag for SOUTHWEST CORNER OFFICE.
2. On the Modify | Room Tags tab, click the Edit Family button.
3. With the family file open, click the Room Name piece of text that is visible. (These pieces of text are actually labels.)

4. On the Modify | Label tab, click the Edit Label button.

5. In the Edit Label dialog box, the list to the left displays all the parameters that you can add to the room tag (see Figure 14.12). Don’t change anything; click OK.

![Figure 14.12: A list of available parameters that you can add to the room tag](image)

**WARNING** If you’re modifying the room tag, do yourself and the rest of your design team a huge favor and inform everyone that you’re changing your company’s standards! If you’re the BIM manager, set the permissions to this network directory accordingly.

6. Close this file without saving any changes.

Now that you know what tag Revit uses when it places a room and how to manipulate that tag, let’s tie the tag into something more robust. A tag is just a reflection of the room data. You can add another Revit object that does the same thing: a room schedule.

**Adding a Room Schedule**

Up to this point in your career, you’ve been adding room information twice, or sometimes three times. Why? Because you had to fill out the tag in the plan and then fill out the same information in the room schedule. If you were in the
unfortunate situation of having an enlarged plan, then you added the information a third time. When you needed to change that information, you had to do so in several places. I'm not saying that Revit will end all your problems, but it sure will make life easier.

The objective of the next procedure is to create a room schedule. You'll then finish filling out the room information from the schedule, thus saving time and increasing accuracy. Follow these steps:

1. On the View tab, click Schedules, and then click the Schedule/Quantities button.
2. In the New Schedule dialog box, select Rooms from the list at the left.
3. Click OK.
4. On the Fields tab of the Schedule Properties dialog box that opens, add the following fields in the specified order (see Figure 14.13):

   ![Figure 14.13: Adding fields to the schedule](image)

   - Number
   - Name
   - Base Finish
   - Wall Finish
   - Floor Finish
   - Ceiling Finish
   - Comments
   - Level
5. Click the Sorting/Grouping tab.


7. Click OK. Your schedule should look similar to Figure 14.14.

![Figure 14.14: The room schedule](image)

8. With the schedule still open, click into the EAST ENTRY Base Finish cell, and type WD-2.

9. Click into the Floor Finish cell, and type TER (for Terrazzo).

10. Click into the Wall Finish cell, and type VINYL.

11. Click into the Ceiling Finish cell, and type a hyphen (-).

12. Click into the EAST WING CORRIDOR Base Finish cell. Click the menu arrow, as shown in Figure 14.15. You have a choice between two base finishes; choose WD-2.

![Figure 14.15: Filling out the room schedule](image)
13. Change the other values to VINYL, TER, and ACT (see Figure 14.15).

With the rooms in place and a schedule filled out, let’s move to a more colorful aspect of placing rooms in the model: adding a color-fill plan.

### Turning Off Unwanted Rooms

Your model may have an errant room that doesn’t belong in the schedule. Because going step-by-step through a book doesn’t give you a true feel for a real-world scenario, I can tell you that you’ll wind up with some misplaced rooms. This is OK, because you can turn them off in the schedule. If you click the Not Placed/Not Enclosed menu, you’ll see that you can show, hide, or isolate unwanted data. For this example, choose Hide to remove the row, as shown here:

![Image showing how to turn off unwanted rooms](image)

### Adding a Color-Fill Plan

Another benefit of using the room feature in Revit is that you can add a color-fill plan at any time, and you can create virtually any type of color or pattern scheme you desire. Here’s the best part: adding one is so easy, it’s almost fun.

In this procedure you’ll make a duplicate of the East Wing floor plan and create a color scheme based on room names. Follow these steps:

1. Right-click the Level 1 floor-plan view, and select Duplicate View ➔ Duplicate With Detailing, as shown in Figure 14.16. If you get an error pertaining to the view references, click the Delete button.

2. Right-click the new view, and select Rename.

3. Rename the view Level 1 Color Plan.

4. Click OK.

5. Open the new plan if it isn’t open already.

6. On the Analyze tab, click the Color Fill Legend button, as shown in Figure 14.17.
7. Change Space Type to Rooms and Color Scheme to Name (see Figure 14.18).

8. Place the color scheme into the model in the upper-right corner of the view (inside the crop region).
9. Click OK. You have a nice color plan.

10. Select the color scheme legend.

11. Click the Edit Scheme button on the Modify | Color Fill Legends tab, as shown in Figure 14.19.

12. In the Edit Color Scheme dialog box that opens, you can alter the color and the fill pattern for each room. After you investigate this area, click OK.

Pretty cool concept! You may notice that the two rooms you skipped are still white. It’s time to look at this situation. The problem is, there are no walls dividing the two rooms, but it would be nice to have two separate rooms anyway. To do this, you can add a room separator.

**Adding Room Separators**

Although it seems like a small issue, adding room separators has been known to confuse people. In Revit, you can physically draw a room without any walls. Or you can draw a line in the sand between two rooms that aren’t separated by an actual wall. This is known as adding a *room separator*. 
Let’s separate the kitchen from the break room by adding a room separator.

1. In the Level 1 floor plan, zoom in on the area shown in Figure 14.20.

2. On the Room & Area panel of the Architecture tab, click the Room button.

3. Place a room over the top of the tile flooring (see Figure 14.20).

4. On the Room & Area panel of the Architecture tab, choose Room Separator, as shown in Figure 14.21.

5. On the Draw tab, click the Pick Lines icon.

6. Pick the edge of the flooring, as shown in Figure 14.22.

7. Click the Room button.

8. Place a room to the right of the kitchen area.
9. Change the room to the left to KITCHEN.

10. Change the room to the right to BREAK.

You’re really moving along. You now have a fully coordinated room schedule tied into a room color-fill plan that can be modified by simply changing a room tag. How did you ever live without Revit?

The next item we’ll discuss is how to create a gross area plan. The process is similar to, but slightly more involved than, creating a room color plan.

**Creating an Area Plan**

Almost any job of considerable size will require an area plan at some point in the project’s early development. This normally occurs in the programming phase, but the need for this type of plan can persist well into the later stages of the project.

The goal of the next procedure is to create a separate floor plan and then divide it into areas. Follow these steps:

1. On the Room & Area panel of the Architecture tab, select Area, and click the Area Plan button, as shown in Figure 14.23.
2. In the New Area Plan dialog box, choose Gross Building from the Type list, and choose Level 1 for the Area Plan Views.

3. Click OK.

4. Click Yes to create area boundaries automatically. You now have a new floor plan with a blue boundary around the perimeter of the entire building.

5. On the Room & Area panel, click the Area Boundary button, as shown in Figure 14.24.

6. Draw a line, as shown in Figure 14.25, separating the corridor from the east wing.

**Figure 14.24**: Clicking Area Boundary

**Figure 14.25**: Separating the areas
7. Draw another similar separator between the west wing and the corridor.

**NOTE** If your lines aren’t exactly snapping to the endpoints, it isn’t a big deal. Unlike Sketch Mode, Revit is much more forgiving when it comes to creating area separations.

8. On the Room & Area panel, click the Area button, as shown in Figure 14.26.

![Figure 14.26: The Area button](image)

9. If Revit says a tag isn’t loaded, click Yes to load the family. Browse to Annotation ➔ Area Tag.rfa.

10. Place an area in the west wing, then in the corridor, and then in the east wing, as shown in Figure 14.27.

![Figure 14.27: The plan is divided into three areas.](image)
11. Select the tag in the west wing.
12. Rename it WEST WING.
13. Click the Corridor tag.
14. Rename it LINK.
15. Click the East Wing tag.
16. Rename it EAST WING.
17. On the Color Fill panel of the Annotate tab, click the Color Fill Legend button.
18. Place the legend in the upper-right corner of the view.
19. In the Choose Space Type And Color Scheme dialog box, choose Areas (Gross Building) for Space Type and Gross Building Area for Color Scheme.
20. Click OK.
21. Select the color scheme legend.
22. Click the Edit Scheme button on the Modify | Color Fill Legends tab.
23. For Color, change Area Type to Name.
24. Click OK in the warning dialog box.
25. Click OK to return to the model (see Figure 14.28).

26. Save the model.
Great job! You now have experience with creating area plans. If you feel as though you could use some more practice before you begin a real project, there are five more floors in this model that you can work on. You can either work on your own or step back through this chapter’s procedures.

**Are You Experienced?**

**Now you can...**

- ✔ add rooms to the model
- ✔ add room separators to the model
- ✔ create color-scheme plans
- ✔ create area plans
- ✔ create room schedules
- ✔ update the rooms in the model directly from a room schedule